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NovaMind

Your Mind Mapping creativity enhancing tool

by NovaMind Software

Produce unique, information rich, vivid solutions for
enhanced creative thinking and compelling presentations.

Smooth curves and colorful pictures create powerful images
for your brain to remember. Branches can be contoured to
your liking for a Mind Map that will reflect your own distinct
style. Our unique Branch Proposal System suggests new
directions for your thoughts, generating additional ideas and
prompting exploration of more options.

The information stored in your mind map is compact and
meaningful, allowing you to see the important issues,
organize your thoughts, and solve problems quickly and
effortlessly. The solutions are new and effective, and can
easily be presented to others using graphical or text
representations. NovaMind makes Mind Mapping intuitive
and fun.
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All about Mind Mapping

This section gives a brief overview of Mind Mapping, how you can benefit from using it, and an
introduction on how to Mind Map. There is more information available from the NovaMind web site.

What is a Mind Map?

The Mind Map is simple to make, because it works just like your brain and memory.

So how does it work? A Mind Map is:

1. A way of remembering information

Information is presented in a form that is logical and easy to remember. Recalling a branch leads to
memory of the sub-branch details. Students can put information into this form for recall in
examinations.

2. A way of generating ideas

You have one idea but it seems to go nowhere. Make it the title of a mind map. The branches prompt
you to add ideas at another level. A structure emerges. Soon that idea has become a whole concept.
The mind map keeps all your ideas in front of you in a clear form. Each new idea is a center of thought
for more new ideas.

3. A way of organizing thoughts

When you have a number of thoughts and want see how they relate to each other, starting a Mind Map
helps get them organized. You will be able to pick out the main thoughts and see how the others relate
to them.

4 Works from overview to details

The main branches convey the overall picture, while the sub-branches give the key points or details.
You can see quickly how items are related and inter-dependant. The mind map brings clarity to
complex material.

5. Focuses your mind on the main issues
The mind map enables you to see at a glance, what is important. As you work, your whole brain and all
your skills come into play. Mind mapping is fun.

6. Helps you to solve problems

The very act of making a mind map around a problem, helps you to see possible solutions and to
select the one that will meet all your criteria.

7. Compact
By making use of color, shape, style, layout and fonts, a Mind Map can hold a large amount of
information in a small space. A whole complex concept can be presented on one page.

8. Graphical
Mind Maps give the whole story in one picture. Your map can be easily read by others.

9. Uses words

Using text allows your ideas to be expressed accurately. You can use your own language. You can
form a document from your mind map.

10. Uses color

Ideas can be linked by using the same shape for their boxes, or the same color for the branches.
Emotions can be conveyed, and importance stressed.
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11. Can be used for training and job instruction
Each branch is an important step in an operation and the sub-branches are the key points in each
step.

1.2  What would | use a Mind Map for?

Problem solving

Create a mind map including all the factors involved in the problem. The map will prompt new aspects.
Include them all as branches. New pathways will open up. Your linear thinking will now become lateral

thinking. Give priority to the important issues by color, shape or number. Now weigh up the options and
proceed with the best solution.

Learning

Use a map to take notes of a lecture. Main branches are the important aspects, child branches, the
detail. To summarize the contents of a book, the parent branches are like chapter divisions, and the
detail is shown in the offspring branches.

Use your mind maps for learning. A single map can cover much information. The layout helps you
focus on the main issues.

Thinking
Mind maps give vitality to information, and help your mind concentrate. Ideally suited to brain storming,
ideas can be quickly recorded so that the flow is not interrrupted.

Association between ideas is immediately obvious, and everybody's creative force is brought to bear
on the subject. When the ideas dry up, try the "what if?" and reversal approaches. Soon your thinking
is clear and your ideas can be put into practice.

Organizing
When you list the things that need to be done, the order of the branches gives the succession of tasks
and the proirities. Sub-items are shown as sub-branches so that no key activity is lost.

The map highlights the resources needed to carry out the total operation.

Communicating

Talks and presentations become clear and concise when directed by a mind map you have prepared
in advance. You are kept on track; your time is balanced over the main topics and the audience can
see the whole picture. The presentation will have an informality that reflects the fact that you have
organised the material well.

Agendas can be mind-mapped and notes of the proceedings jotted on your mind map for formal
recording in minutes.

Technical documantation becomes clear when a mind map shows the main operations and the
details.

Teachers and lecturers can use the mind map to plan lessons and series of talks.

1.3  What are the benefits of Mind Maps?

Scientists have identified four main areas of our conscious brain function. The mind mapping process
stimulates all four areas to produce a unique map.

We use logic, lines, numbers, words, lists, rythm, colour, daydreaming, and imagination to produce a
whole picture of our thinking on the subject - a mind map. The use of all these brain functions together
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1.4

produces a great feeling of achievement.
Why use Mind Mapping software?

Quicker and easier to create Mind Maps
A few key strokes/mouse clicks, and you create branches as you need them, and type in the
information.

Can be represented in multiple formats

A Mind Map created with NovaMind can be printed as text or as a picture. The text version preserves
the structure and order of the branches, and indents them appropriately. You can reference branches
by number.

You can export the Mind Map from NovaMind in several formats for working with other software.

For a colorful memory jogger
It is easy to drag the branches to the place you want them. You can choose branch colors, let the
"Rainbow Colours" operate, or combine these methods.

To add visual interest, adornments may be included, and branches may be shaped from line to oval,
rectangle or image.

Notes and graphics can be added to extend the visual appeal and information of the branches. The
result is an easily remembered picture.

Easy to share with others
Email your Mind Maps to others, or print them in different formats. Thus, NovaMind maps may be
shared more easily than those we drawn by hand.

Spend more time on the contents rather than drawing
NovaMind will draw the branch lines neatly, color them automatically, and draw the shapes for your
branches. You can concentrate on the material.

When all has been recorded, you can easily make it look the way you please.

Result is neat and professional
The NovaMind software makes you an artist. With it, you can create a stunning Mind Map which looks
professional and convincing.

Easy to edit

Use NovaMind to space the branches according to the number of child branches. Let the software do
the tricky, time-consuming work. Editing can be done as you go or left to the end. No rubbing out - no
re-spacing - no frustration.

Link descriptive text to branches for printing
With NovaMind, formatted text may be attached to any branch. This text can be printed with the full
text outline of the Mind Map. No extra documents are needed as in traditional mind mapping.

Live links to other Mind Maps and documents
In NovaMind, you can create hyperlinks on any branch, which can open other NovaMind documents on
your machine or over the Internet, and select the branch you want.

You can link to any file on your own machine or over the Internet, and NovaMind will open that file in
whatever program you have set up to open that type of file.
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You can even have the hyperlinks compose a mail message within your eMail program.
1.5 How to Mind Map

e Gather information for your Mind Map

e Select the topic - one or two words - type in box

e Start at the center, perhaps with an image to represent the topic
e Add the top level ideas - a main branch each

o Capture all the ideas first; organize & elaborate later

e Each Mind Map yours - it is neither right nor wrong

e Add emphasis with color, images and layout

e Use sub-branches to include secondary items

e Humor, colors and layout will make it easy to remember.

2 Getting Started

This section tells you how to get up and running with NovaMind.

2.1 Installation
To install NovaMind, firstly download the NovaMind application from the Downloads section of the
NovaMind web site. It will come as an MSiI file, something like NovaMind4Pro432.msi (where 432
would be the version number).

Double click on the MSiI file to start the installation.

The installer will be signed using our legal company name NMS Global Pty Ltd, and will look
something like this:

i =

Open File - Security Warning (=23

Do you want to run this file?

Mame: .. deon\Downloads\NovaMind4Platinum408-1.msi
Publisher: MMS Global Pty Ltd
Type: Windows Installer Package

From: Z:\Users\gideon\Downloads\MovaMinddPlatinu...

Run I [ Cancel

I | While files from the Intemet can be useful, this file type can
\ lﬁ patentially ham your computer. Onby run saftware from publishers
S= youtrust. What's the risk?

The first screen that will appear looks like this:
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5 NovaMind 4 Pro

Welcome to the NovaMind 4 Pro Setup Wizard

The ingtaller will quide vou through the steps required to install Novakdind 4 Pro on vour cormputer.

WARMIMG: This computer program iz protected by copenght law and international treaties.
Unauthorized duplication or distribution of this pragram, or ang paortion af it, may result in severe civil
or criminal penalties, and will be prozecuted to the masimumm extent pozsible under the law,

Cancel | < Back

Click on the Next button to show the next screen of the installation procedure:
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‘jEJ MovaMind 4 Pro

License Agreement

Fleasze take a mament to read the license agreement now. |f pou accept the terms below, click "l
Agree", then "MNest". Otherwize click ''Cancel”.

WARNING: -

Permizsion to use the Novahlind Software [“Software™) 1= conditional upon You,
the Customer, agreeing to the terms set out below. You must read this contract
carefully. By using all or any portion of the Novahlind Software [“Software™) Tou
accept all the terms and conditions of this Agreement. Acceptance shall bind You
and all of Your employees in terms of this License. Including, in particular, any
limitations on use, transfer ability, warranty and lability. You agree this
Agreement is enforceable in the same manner as any written negotiated contract
sighed by You. If You do not agree, do not use this Software and return it to

I Do Mat Agree @ | Agree

Cancel I I < Back I [ Mext >

You will need to click on the | Agree option to accept the license agreement and continue. Make sure

you have read and understand the license agreement before agreeing to it. Click on the Next button to
go on to the next screen:

© 2007 NovaMind Software



NovaMind Documentation

_[é"-_,J MovaMind 4 Pro

Select Installation Folder

The ingtaller will ingtall M ovatdind 4 Pro to the following folder.

Toinstall in thiz folder, click "Mest'. Ta install to a different falder, enter it below ar click "Browse"',

Eolder:
C:5Program FilezhMovabdind SaftwarehMovatdind 4 Pro | Browse. . |
| DiskCost. |
Install MovaMind 4 Pro for yourself, or for anyone who uses this computer:
Everpone
@ Just me
Cancel | | < Back | | MHext >

The default installation location is usually correct for most people, but if you need to install somewhere
else, choose the installation location where you would like NovaMind installed by using the Browse
button or typing in the new location.

If you are short of disk space, you can see exactly how much disk space is available on all your disks
and how much will be used by the installation, so you can choose the best place to install.

If you attempt to install on a disk that doesn't have enough space, you will be told and will need to
either choose a different installation location or free up some space on your disk.

Choose whether to install for everyone on your computer or just for you.

Click on the Next button to go on to the next screen of the installation:
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‘jEJ Movahind 4 Pro

Confirm Installation

The ingtaller iz ready to install Movakdind 4 Pro on your computer.

Chck "Mest" ta start the installation.

You are now ready to start the installation of the files on to your computer. If all is OK, click on the Next
button and the installation will commence and you can follow the progress with the progress bar.
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Installing NovaMind 4 Pro

Movatdind 4 Pro iz being installed.

Fleaze wait...

Once the installation is complete, you will see the following screen:
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5 NovaMind 4 Pro

Installation Complete

Movatdind 4 Pro haz been successiully installed.

Chck "Cloze" to exit.

Fleaze uze Windows Update to check for any critical updates to the MET Framework.

Cancel < Back Cloze

This means that the installation has completed successfully. Note the message at the bottom of the
screen to use Windows Update to check for .NET updates. NovaMind requires .NET 3 to run, and
from time to time there may be bug fixes for this framework released by Microsoft. In most cases you
would have Windows Update running automatically to check for updates, but if you don't you can run it
by using the Control Panel / Security / Check for Updates option. If you didn't have .NET 3 already
installed when you install NovaMind, the installer will direct you to the download page so you can
download and install it.

Command line installation options

The .MSil file can be installed using the msiexec program from the command line, with the relevant
command line options. Please see the Microsoft documentation of the options

Sample Mind Maps

The installer installs a number of sample Mind Maps, and puts a link to them in the NovaMind Software
group in your start menu. These files will have already been registered to NovaMind, so you can just
double-click a file and it will open in NovaMind.

Other Downloads

Note that there are also other downloads of the Suggesterator! 33 as well as multiple Graphics
Libraries| 44" with over 1,400 high quality images for you to use in your Mind Maps. These are installed
by downloading the installer files and running them.

Uninstallation

If you need to uninstall NovaMind at any stage, you can either double-click on the MSI installer file
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again, and you will be given the option to either repair or uninstall NovaMind, or you can remove it

through the control panel.

To remove NovaMind using the control panel, if you are using Windows XP, go to the control panel

and use the "Add and Remove Programs" option to remove the old version.

To remove NovaMind using the control panel, if you are using Windows Vista, go to the control panel

and use the "Uninstall a Program" option under the programs section, and select NovaMind from the

list, and then click on the Uninstall option at the top of the list of programs to remove it.
2.2  User Interface
The NovaMind user interface is implemented based on the Microsoft Fluent user interface concept.
Here are some key aspects of the user interface:
alﬂ H9 3 Drawing Tools NovaMind 4 Pro i — i
1 Home 2  Insert Map Design View Farmat 9 @ Help ~
ity i - Pl = - | = .
= *5 A f@ J’O Tahorma - 15 ~ (A A EEE J’/ Sl shench \i_Frd
| S . L shape Outline * &% Replace
Tde m Branch ¢ Shape |B J U vaber BB xde|| A | A€ Quick i
-6 il i E'a_"cr' - Styles ~ Select *
Clipboard & Insert Font Paragraph Drawing T Editing

1. The Ribbon Bar which holds all the commands you will use to work with your Mind Map.

2. Tab - the ribbon bar has a number of tabs, each covering a functional area of the program.

3. Contextual Tab - a tab that only appears when appropriate. In this case it is the formatting tab that
only appears when you have a branch or shape selected.

4. Command Group - a box that groups a collection of related commands.

5. Commands - each icon or button represents a single command. Some commands are also shown
on popup menus.

6. Menu Triangle - Indicates where there is a menu which will be shown when you click on the triangle.
When you put your mouse over the button, you will either see a single button with the menu triangle
on it, or a split button with one part of the button having the menu triangle on it. If the button is not
split, it will always show the menu when clicked. If it is split, it will issue a hormal command when
you click on the main button, and only show the extra options in the menu if you click in the part of
the button with the menu triangle on it.

7. Dialog Box Launcher. This button launches a dialog box with detailed commands related to the
command group. You can keep the dialog box open if you choose.

8. NovaMind Application Menu. This button shows all the file and document related commands.

9. Help. Click here to show the options for accessing the help documentation, visiting NovaMind,
licensing, and sending feedback to NovaMind.

2.3  Creating your first Mind Map

The following describes the basic creation of a Mind Map. There are a number of ways of
accomplishing these tasks (shortcut keys!| 47, context sensitive menus| e etc), which are dealt with in
other places in the documentation.

When you start NovaMind, it will initially have a Mind Map already created for you, or you can create a
new file by clicking on the NovaMind Application Menu, selecting File / New Document. If you would
like to use one of the supplied templates you could use the New Document from Template option and
choose a suitable template for your needs. For the moment, we will assume that you are starting with a
blank Mind Map.
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Type in the Mind Map title.

Your Ribbon Bar should be showing the Home tab, so click on the option to add a Child Branch in the
Insert group.

H \ = 9 Shape NovaMind 4 Pro Beta - B X
| Home Insert Map Design View Format € Help ~
e L1 - -
— S| Sho / Shape Fil =  aFind
B L ome v 2 - |A x| (EEE shape il "
Child S L shape Outline *  §%Replace
Paste Branch| 9 lshape (B 7 U vabev ABv x2v||A | [a24y| | Quick
T | . [erancn] — = = Styles = [ setect ~
Clipboard Insert Fomnt Paragraph Drawing F] Editing

If you want to add a different type of branch than the default branch type shown, click on the Menu
Triangle and select the type of branch to add.

You can also create child branches by pressing Insert, and
sibling branches (i.e. at the same level) by pressing Enter
(unless you have changed the key bindings in the Ogtions!?ﬁ

)

Type the title of the branch.

You can continue adding branches using the Insert / Branch option or Insert / Child Branch option.
You can also add child branches of the default type using the Suggesterator!?ﬁ if you have it installed.
Repeat until you have completed adding the information you want in your Mind Map.

If you want to add text to a branch that you are currently not editing, select it by double-clicking on the
branch text then typing.

2.4  Saving your first Mind Map

To save your Mind Map, select the NovaMind Application Menu (the round button with the NovaMind
logo in it) / Save option from the menu (or use Ctrl+S). Choose the location to save the file. NovaMind
files are saved with the filename extension nmind.

[ Inthe General Options!| 51 pane, you can set NovaMind to save your files automatically at set
intervals

When you first run NovaMind, it is set up so that it saves a backup copy of the previous
version of your files with a Filename.nmbak name. If you don't want this to happen, you can
turn it off in the General Options!si pane. If you need to restore from a backup file, you just
need to rename it with a .nmind extension and you will be able to open it.

3 Licensing

This section tells you all about the different types of licenses, how to enter license keys etc.
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3.1

3.2

Software End User License Agreement

Rather than reproduce the whole End User License Agreement here, you can view it on our web site
at http://www.nova-mind.com/EULA.html. You must agree to the terms of this agreement to use the
software.

How to purchase a license

You can either purchase a license from the NovaMind web site, or directly from within the NovaMind
application.

Purchasing from the NovaMind web store

From the Web Site, click on the Store tab at the top of the web page, which will take you to the web
store, where you can add NovaMind products to your shopping cart and complete the checkout
process.

Enter your details, including any coupon you may have for an educational user discount (which you
must apply for prior to purchasing - we can't process the discount when you have already purchased,
as we get charged transaction fees for the full purchase plus the partial refund, and it all ends up
costing too much in both time and fees).

If you would like to also receive all of the downloads on CD, please select the CD option. Note that
everything on the CDs is available for download from our web site, and this is just something we offer
for your convenience.

If you would like to purchase something else in this transaction, such as paid support or Mind Mapping
books, add the other items to your shopping cart before you check out.

Enter your personal and credit card information (if paying by credit card) and click the Complete
Purchase button.

You will see the full order details including the final price including any applicable taxes in your chosen
currency prior to submitting your order for processing. Note that the base currency for all our
transactions except PayPal is US dollars, and other currency amounts are shown as indicative pricing
only, and although the amounts are unlikely to vary much at all, any variance is outside our control.
PayPal payments are made in Australian dollars, and amounts will be converted automatically at a
competitive rate by PayPal.

Once your order has been processed, you will see the receipt on your web browser with your
NovaMind license key in it. This information will be emailed directly to you as well.

¥y You will see mention in a number of places on
our web site of a product called Merlin. This is
a Mac OS X only project management
application and will not run on Windows.

Purchasing from within the NovaMind application

To purchase from within NovaMind, select the Licence option from the Help menu, and click
"Purchase". You will be taken to our online store to complete the purchase.
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3.3

3.4

Entering a license key

When you purchase a license key from the NovaMind web site, or need to re-enter the license key
(after a re-install etc), Select the "Help / License" menu option, then click the "Enter New License"
button. Licenses are valid for all releases within a major revision of the product edition you have
purchased. For example, a NovaMind Express 4 license key will work in NovaMind Express 4.3.2 but
not in NovaMind Express 5.0 and not in NovaMind Pro 4.3.2. Major revision (e.g. v4 to v5) upgrades
are paid upgrades.

The licence key you received from NovaMind will be a series of letters and numbers. The best way to
enter this is to copy and paste it in rather than typing it. The license key is not case sensitive.

1 Enter License Key El@
First Name!  First

Last Mame: | |aet

Company Company

eMail: first@company.com
Subzcribe to Mewsletter

License Key:

By clicking the Activate button, your activation information will be sent to
Movahdind via secure internet connection, as per the MovaMind End User
License Agreement. This information will be used only in strict accordance
with our Privacy Policy, and will not be disdosed to any unauthorized third
party.

Activate H Cancel |

Enter your first name, last name, email and company name as well as the license key.

If you would like to receive our newsletter, leave the "Register for MindMap Connection Newsletter"
option checked. Note that this will add you to the newsletter if you have not already subscribed to it - if
you do not check this option, it will not remove you from it if you are already on it. All our newsletters
include a link to manage your subscriptions, and you can click on the link to remove yourself from the
list if you so desire.

Click the Activate button to complete the registration and activation process. An internet connection is
required for activation. We respect your privacy and will not release your information to anyone or use
the information for any purposes other than NovaMind related messages.

NovaMind will check that the license is valid, and has not expired, and if all is OK, will accept the
license and show you the license details.

Demo mode

When you first download NovaMind, it comes with a 30 day trial license so that you can try all the
features (30 days from the first time you run NovaMind). Each time you start NovaMind, it will tell you
how long you have remaining until the end of the trial period.
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You should purchase before the end of the trial period to ensure uninterrupted operation.

If you have still not entered a license key by the time the trial period is up, NovaMind will drop back to
its second level demo mode where you will not be able to save or export the Mind Maps you have
created. You will be able to print, however there will be an UNLICENSED watermark on your output
which will be removed only once a license is purchased.

Types of license

Edition Information

Make sure you purchase the most appropriate version of NovaMind for your needs. Information about
the different versions is below, and there is more information on the different feature sets at http://
www.nova-mind.com/Features.

NovaMind Express

NovaMind Express is the lowest level of NovaMind, and contains all the things you need to get started
Mind Mapping. It does not have all the advanced features of NovaMind Pro and Platinum, like multiple
Mind Maps in a single file, detachable inspector palettes, presentation mode, screenwriting, project
related information, and only has basic import and export capabilities.

NovaMind Pro

NovaMind Pro has many more features than Express, and is designed for the frequent Mind Map user,
and is suitable for general business use. It has the ability to create multiple Mind Maps in a single
document, hyperlinks and checkboxes on branches, more advanced imports and exports, detachable
inspector palettes, and the ability to create your own reusable templates etc.

NovaMind Platinum

NovaMind Platinum is the top of the range Mind Mapping application, designed for serious business
users, project planners, presenters, and screenwriters. It has all the features for project planning and
task information recording, the complete presentation module for doing professional presentations, the
screenwriting module for writing screenplays, and high resolution graphics libraries with up to 8 times
the number of pixels, enabling you to create even more stunning Mind Maps.

License Types

Single user license

A Single User license allows a single user to use NovaMind. You may use this license for either a
single computer where different people use NovaMind on that computer at different times, or for a
single user who has several computers. You may not have more than one person using one single-
user licence at any given time.

For single user licensing, each installation and user will require the entry of the license key. Free
upgrades do not require re-entry of the license key as this information is saved under your user
settings.

Multi-user license

When you purchase a license for multiple users, you still receive a single license key. You can enter
that license key on as many computers as you require, so long as the maximum number of concurrent
users does not exceed the number of users you have licenses for.
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Site license
A site license is the same as a multi-user license, but it doesn't have a limit on the number of people
who can access it. Site licenses are valid for all the users at one physical site.

Windows and Mac

The same license keys are used for Windows and Mac, so if you have a single user license for
instance, and you have a Mac at home and a PC at work, you will be able to use the same license in
both places so long as you only use one copy of NovaMind simultaneously.

Support & other products

We offer both a high quality free support service, and a paid support service which puts you at the
head of the queue to get your issues resolved quickly, and gives you extra information and lines of
communication with us. See our web store for a full description of our support services.

The creator of NovaMind and founder of the NovaMind company, Gideon King, has written a book
entitled "Teacher's Guide to Mind Mapping", which is available through our web store. He is currently
writing other Mind Mapping books.

Viewing your license information

To display your license information, select the "NovaMind / License" option from the menu. You will
see a window like this:

I "

¥ Licenze Information =[][R]

Crwner Details

[ Mame: Administrator
&J Company:

License Details
Type: Single User License
Expires: Mever

Ok [ Enter Mew License l [ Purchase

The following is an explanation of the information you see on the license information panel:
Name and Company - As entered during the registration process.
License type - Either single user or for a number of users, or a site license.

Expires - If this is a temporary license, this shows when it will expire.

Edition Information

Make sure you purchase the most appropriate version of NovaMind for your needs. Information about
the different versions is below, and there is more information on the different feature sets at http://
www.nova-mind.com/Features.

NovaMind Express
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NovaMind Express is the lowest level of NovaMind, and contains all the things you need to get started
Mind Mapping. It does not have all the advanced features of NovaMind Pro and Platinum, like multiple
Mind Maps in a single file, detachable inspector palettes, full screen editing, presentation mode,
screenwriting, project related information, and only has basic import and export capabilities.

NovaMind Pro

NovaMind Pro has many more features than Express, and is designed for the frequent Mind Map user,
and is suitable for general business use. It has the ability to create multiple Mind Maps in a single
document, hyperlinks and checkboxes on branches, more advanced imports and exports, detachable
inspector palettes, and the ability to create your own reusable templates etc.

NovaMind Platinum

NovaMind Platinum is the top of the range Mind Mapping application, designed for serious business
users, project planners, presenters, and screenwriters. It has all the features for project planning and
task information recording, the complete presentation module for doing professional presentations, the

screenwriting module for writing screenplays, and high resolution graphics libraries with up to 8 times
the number of pixels, enabling you to create even more stunning Mind Maps.

Registering for update information

When you purchase NovaMind directly from the NovaMind application or from the NovaMind web site,
you will be asked whether you want to register for update information and newsletters.

We respect your privacy and will not disclose your information to anyone or use the information for any
other purposes than NovaMind related messages.

All messages we send will have a link at the bottom for you to be able to either update your
email Options or to unsubscribe from any subscriptions you may be subscribed to.

Alternatively, you can remove yourself from this mailing list at any time by sending a message with
"unsubscribe" in the title to registrations@nova-mind.com.

Adding Items To Your Mind Map

This section of the manual describes how to add new Mind Maps to your document, and how to add
branches, graphics and link lines to your Mind Maps.

Please see the detail sections for more information on:

Creating Mind Maps using Templates/ 18}

Adding Mind Maps to your Document/ 197

Adding Branches to your Mind Map| 20

Adding Link Lines to your Mind Map/| 21

Adding Attached Graphics to your Branches/ 21
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4.1

Creating Mind Maps Using Templates

Templates are pre-defined starter Mind Maps that come with NovaMind to help you get started quickly
in creating your own Mind Maps.

When you create a new Document or Mind Map using the NovaMind Application Menu, you will have
the option to select from templates - either choose the "New Document from Template" or "New Map
from Template" option as appropriate:

NovaMind 4 P

New 1..”} Mew Document
Create a new document using default settings

ﬁ,]f - Mew Document from Template

Open ‘Hﬁ Create a new document by choosing from
different Templates and Themes

Sava i Mew Map
Add a default map to the document

Mew Map from Template
Add a Map by choosing from
different Templates and Themes

Save As..

)
ﬁ Print
.I ” J

l _|Close

[ 2] Options ] l-';i Exit Movahtind

Also if you are adding a new Mind Map to an existing document, you also have the option to add a new
Mind Map from a template by clicking on the arrow beside the add Mind Map tab:

B

B2 MNew Map

E= MNew Map From Template

You also have similar options on the popup menu under New Map in the Insert tab of the ribbon bar.
You will be shown a screen where you can choose the template and theme. A template is like a pre-
made Mind Map, and a theme alters the look of the Mind Map to make it different and interesting.
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On the left is a place for you to select from the different categories of templates available, then in the
center you can choose the template to suit your needs. On the right is a collection of themes that you
can choose to apply to the template. Click on a theme to see how it will look when applied to your
template. If you like the template as originally designed, you can just click the Create button without
selecting a theme, but if you have already selected a theme, you can revert to the original Mind Map by
clicking the No Theme option.
You can create your own templates using the Save As Template option in the application menu. The
template will include all the Mind Maps in the document under the name you choose for the template.
4.2  Adding Mind Maps to your Document

NovaMind Pro and Platinum documents can contain multiple Mind Maps.

There are three ways of adding new Mind Maps to a NovaMind document:

1. Click on the Plus icon beside the last Mind Map tab just below the ribbon bar, or

2. Select the hold the Control key while dragging the tab for the Mind Map to duplicate the map., or

3. Select a branch and choose the New Map From Branch context menu item to create a new Mind
Map with the selected branch as the title and its children added as children of the new Mind Map.

To delete a Mind Map from the document, just click on X icon on the tab for that Mind Map and it will
be deleted. If the Mind Map is not empty, you will be prompted to confirm that you do really want to
delete the Mind Map.

To re-order the Mind Maps within the document, just drag them into the desired order.
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To copy a Mind Map from one document to another, just drag the tab from one document to the other
one.

4.3  Adding Branches to your Mind Map
This topic describes how to add branches to your Mind Map using the ribbon bar and hotkeys.
Adding branches using the Ribbon bar:

On the Home tab, there is an Insert command group, and it has options for adding a branch (which will
be added as a sibling of the selected branch), or to add a child branch. The shape of the branch is
denoted by the shape of the branch shown on the button. This is determined by the theme if you are
using a theme. If you want to insert a different shape, you can use the arrow at the bottom of the
button to pop up a menu of options from which you can select the branch type to add.

On the Insert tab, you have options to add the different branch types directly with a single click.

On the shape Format tab, there is also an Insert command group which is exactly the same behavior
as the one on the Home tab.

Adding branches using the Suggesterator:

If you have the Suggesterator installed (it is available for free download from the NovaMind downloads
page), and it has some suggestions for branches to add, then they will appear in the Suggesterator
panel.

To show the Suggesterator panel, click on the little lightbulb icon at the bottom right corner of the
window.

You can select the items you would like to add (hold the Ctrl key while selecting multiple items), and
click the Add Branches button to add the branches. Branches are added as children of the selected
branch. If you would like to have the definitions of the words added to the branch notes for the new

branches, check the Include Definitions checkbox.

If you don't see options that appeal to you, click on the "Give me more!" button to get a different
selection of words.

Adding branches using hotkeys:
You can use the KeyTips to guide you through the options for hotkeys. To activate KeyTips, click the

Alt key. You will see little tags showing you the options for the currently selected area of the user
interface. When you first press the Alt key, you will be shown the key tips for the top level, like this:
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4.4

4.5
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Then when you choose a top level item, you can then choose the detail options etc until you get the
command you want.

So for example to add a new branch, you could use Alt + H + IB, then select the branch type and press
Enter, or you could do it from the Insert tab with Alt + | + CL for a line chld branch.

Adding Link Lines to your Mind Map

Link lines are used to denote secondary relationships in your Mind Maps. You can add link lines to
your Mind Map by using the Insert tab of the ribbon bar, and selecting the Shape / Link Line option.
When you move your mouse cursor over your Mind Map, the cursor will change to a link line cursor.
Move your mouse over the branch or shape you want to start your link line from, and click and drag to
the desired destination. When your mouse is over a valid destination branch or shape, the line will
change to be black, and when you let go of the mouse button while the line is black, your link line will
be created and selected. You can then alter the shape of the line using the handles.

Adding Attached Shapes to your Branches

You can add shapes to the selected branches using the following methods:

Using the Ribbon Bar

You can use the Home tab / Insert / Shape option - if you click on the top part of the button, it will add
the pictured shape, which will be the type of shape you last added. You can click on the arrow to show

the options to add other shapes to the selected branch.

On the Insert tab / Shape command group you have options for directly adding any of the graphic
types directly.

On the Shape Format tab, you can use the Insert / Shape option the same as for the Home tab.
Using hot keys
As adding attached text shapes is a common operation, we have made a hotkey for this: Ctrl+Shift+A

Adding Attached Images
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You can also add images as attached shapes by dragging them from the Graphics Library, or from
other programs such as Internet Explorer or the Windows Explorer. If you have a branch selected and
drag the image on to the background, the image will be added as an attached shape, attached to the
selected branch.

If you drag over a branch that is not selected, you can still add that image as the picture for that
branch, although you would need to have the branch selected to add it as an attached shape.

When the graphic is added, if it is a large image, it will be scaled down proportionally so that it doesn't
take a huge amount of room on your Mind Map. If you don't want this to happen, hold the Shift key
while you drop the image.

When you are resizing an attached image graphic, by default the image is scaled proportionally so that
it is not distorted. If you do want to resize the X and Y axes independently, hold the Shift key down

while resizing the image. Note that all resize operations are lossless and the image will be stored full
size in your NovaMind file and printed at the best resolution when printing your Mind Map.

5 Editing Mind Map Design Properties

The following properties relate to the Mind Map itself and its overall look and behavior. These settings
can be altered for a single Mind Map, or for a group of selected Mind Maps in NovaMind Pro and
Platinum, using the Document View.

Please see the detailed topics on:

Using Themes| 22

Using Map Styles| 23"

Editing Mind Map Background Settings| 247

Editing Mind Map Layout Settings/ 251

Editing Mind Map Color Settings| 261

Editing Mind Map Outline Numbering Settings| 271

Editing Mind Map Task Settings| 2¢"

Editing Mind Map View Settings| 231

5.1 Using Themes

Themes are an excellent way of applying a set of settings to an existing Mind Map. Depending on the
settings for the particular theme, it may include items such as:

The background of the Mind Map, including background colors and images

The outline numbering settings for the Mind Map

The coloring mode for the Mind Map

The layout assistance mode and branch spacings

Branch styles for each level of the Mind Map starting from the Mind Map title, through the first level
branches etc all the way down to as many child level branches as are set in the theme. These styles
may include branch shapes, colors, line settings, fonts, etc.

o Attached graphic styles for each level of the Mind Map starting from items attached to the title
through attachments to all the branches.
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e The default branch style for new branches that are created.

When you create a new Mind Map using a template, you will also get the option to select a theme to
apply to it. You can also apply a theme to your Mind Map at any time, but be aware it will apply the
theme settings to your whole Mind Map.

To apply a theme, select the Map Design tab of the ribbon bar, and click on Themes, and select the
theme you would like to apply. There is a live preview so you will see how the theme would look when
applied.

Using Map Background Styles

Map background styles allow you to set the background image (including tiling, opacity etc) and
background color with a single action.

NovaMind comes with a number of map background styles built in, but you also create your own
styles.

To select a style, go to the Map Design tab and use the Background Styles gallery to select a style to
use for your background. There is a live preview so that you can see what it is going to be like when it
is applied to your Mind Map.

If you want to create your own style, open the gallery by clicking on the down arrow button with the little
line at the top of it, and select the Edit Styles option.

When you do this, you will be put into the map style editor, like this:

r;./ﬁ'x_l = Sree NovaMind 4 Platinum - = x|
I.\‘l—-/’ Home Insert Map Design View Format Background Style Editor @ Help ~
SyBackground ~  Close Style Editor
i 535)
-
Background Styles Background T Editor

Blue Water Save as new Style

To start, either select an existing background style from the gallery, or click the New Style button. You
can then use the Background options to edit the background image and color etc, and then when you
have finished, save your style, and close the style editor.

To delete a Map Background Style

Scroll down to the bottom of the list of map styles in the style selector palette and choose the Browse
Styles menu option. Click on the style you want to delete, and click on the Delete Style button at the
bottom to remove it.
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5.3 Editing Mind Map Background Settings

The Background settings for a Mind Map allow you to set the background color and image for the Mind
Map.

Click on the Map Design tab in the Ribbon Bar and then use the background command to change the
background color or to remove a background image. To see additional options like setting an image on
the background, use the background Dialog Box Launcher for the background (by clicking the box with
the arrow in it at the bottom right of the background Command Group).

These settings can be applied to multiple Mind Maps in your document at once by using the document
view and selecting multiple Mind Maps to apply the settings to.

If you use the dialog box launcher, the full settings panel you see is like this:

Format Background (=

@
»

&1 MNo Background Color
&4 Mo Background Image
&4 Mo Background

Color Custom Colors

Image

Or when viewing the image options:
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Format Background ]

Coler || &4 No Background Color
Image &1 No Background Image
&1 No Bac kground

Image from...

Opacity ] 50
Image Size

Width | | 100 'é
I—eight] 100 s

Mo Tiling MNermal Tiling iling Center

Image Tiling

# | Image Offset
X-Offset ] 0

¥-Orffset ] 0

To set the background color, use the color picker and choose the color you want.

To select an image for the background, choose the Image from file option and choose the image you
would like to use as a background.

The image will be placed over the background, so if there is transparency in the image, the
background color will show through.

You can change the way the image is tiled by clicking one of the tiling buttons.

You can scale the image by adjusting the image width or height. Normally the aspect ratio of the image
is fixed so that the image scales proportionally, but you can click the link icon on the right side of the
panel to unlink the width and height so that you can stretch the image in one direction or the other. If
you find that you want to go back to the original size of the image, click on the Original Size button.

You can also adjust the opacity of the image to let the background show through more. This is very
useful if your image is too overpowering.

You can also adjust the image position so that the image is in the location you want - if you have the
image tiled, the location you set will be the location of the image under the Mind Map title, and all the
other tiles will move accordingly.

If you have a background image and want to remove it, just click the No Background Image option.

Editing Mind Map Layout Settings

The Mind Map layout settings allow you to change the settings for how NovaMind assists with the
layout of the Mind Map.
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These settings can be applied to all the selected maps at once in Document View by using the
document view and selecting multiple Mind Maps to apply the settings to.

The first command is a selection of what layout assistance mode you would like to use - please see
the section of the manual on layout assistancel 471 for a full description of the options for layout
assistance. Click on the top part of the button to toggle to the next state - free -> assisted -> controlled
and back to free layout. If you click on the bottom part of the button, you will be able to select the layout
assistance option you prefer.

To set the actual spacings between the branches, click on the Dialog Box Launcher at the bottom of
the Layout Command Group. You will then see a panel like this:

B Layout Assistance Settings =l ﬂ@
Layout Mode

o & 4
Free Assisted Controlled New-Brand
Layout Settings Mew-Bran
First Level Spacing 100 | MindMap-Title bt New B .
Space between Children an .
Repel Distance 10

|Lc:-ac| Default|

| OK | | Cancel |

You can set the layout assistance mode, as well as adjusting the spacings between the branches.
The spacings shown are applied as follows:

o The first level spacing sets the distance from the center of the Mind Map title to the first level
branches.

e The space between children sets the distance between the branches and their children (except the
distance between the title and the first level branches).

¢ The repel distance sets the distance between branches and their siblings.

On the right is a live updated preview of how the Mind Map will look with those spacing settings
applied. Click the OK button when you have selected the settings you want.

The Arrange command will immediately apply the spacings you have set to the selected branches. If
you want to auto-arrange the whole Mind Map, just select the Mind Map title.

When "Snap Lines" is turned on in the NovaMind Options, if a dragged branch is aligned with another
branch below or above, a blue dashed line will appear, showing you which branch NovaMind has found
for you to align with. Also if the position is close to equal distance between other branches, lines will be
drawn indicating this, and if you let go at that point, the branch will snap to exact alignment.

5.5 Editing Mind Map Color Settings

The Mind Map color settings allow you to set the coloring mode for the Mind Map. When you use the
Mode command button, the setting toggles between rainbow and specified colors.

If you select the specified colors option, all the branches will inherit from their parent's color settings
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unless overridden in the branch. If you select the rainbow coloring option, the colors will be set
according to the color wheel and saturation.

If you are using a theme or branch styles,
these will often override the rainbow coloring,
and in such circumstances, you will not see
any change when changing coloring modes.

When in rainbow coloring mode, you will be able to set the angle of the rainbow colors using the
colorwheel.

If you use the Color Mode Dialog Box Launcher, you will also be able to set the intensity of the colors.

These settings apply to all the selected Mind Maps when in Document View.

Editing Mind Map Outline Numbering Settings
Outline numbers allow you to number the branches on the Mind Map.

Outline numbering always works on the children branches of the selected branch. To turn on outline
numbering for the whole Mind Map, select the Mind Map title and turn on the outline numbering.

To turn on outline numbering, go to the Format tab and use the Numbering command in the Child
Numbering command group.

The Format command allows you to set the map settings for the direction of the outline numbers:

e Starting at the top and going clockwise

e Starting at 3 o'clock and going clockwise

e From the top, down both sides starting with the left side
¢ From the top, down both sides starting with the right side

The "Child outline numbers top down" option is only relevant if the outline numbering is going
clockwise from the top or from 3 o'clock. If this option is turned on, the child branches on the left side
of the Mind Map title will be numbered from the top down. If this option is turned off, the outline
numbers on the left of the map will be bottom up. For most people, you will want to leave this option
turned on.

[ Note that when printing or exporting the
outline of the Mind Map, the order of the
branches is set using these outline number
settings (even if the outline numbers are not
shown on the branches at the time).

You can edit the format of the numbers by using the Child Numbering Format for changing different
levels to be letters or Roman numerals rather than numbers. To add to the settings, click on the plus
button, and choose the format for that level. If you want to remove formatting, just click on the down
arrow beside an existing format setting and choose the Delete option, and it will remove the formatting
for that level.

The outline numbers are normally shown before the adornments, but when you are displaying outline
numbers and have adornments on the branches, you can drag them into a different order relative to
the adornments.
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5.7  Editing Mind Map Task Settings

Checkboxes

To show a checkbox on a branch (or multiple selected branches), click on the Show Checkbox
command in the Checkboxes Command Group on the Format tab of the Ribbon Bar.

If the checkbox doesn't appear, make sure that the checkboxes option is turned on in the View tab.

You can change the state of a checkbox by either clicking on the checkbox itself, or by clicking on the
Checkbox State command, or by selecting the state from the Checkbox State popup.

The "Automatic Checkboxes" setting relates to whether the checked status of the parent branches'
checkboxes is derived from the checked status of their children which have checkboxes shown on

them. As an example, if a branch with a checkbox on it has two children with checkboxes on them,
and the automatic checkboxes option was turned on, the following table shows the possible values:

Child Branch 1 Child Branch 2 Parent Branch
_! Unchecked _! Unchecked _! Unchecked
= partial _! Unchecked = partial

™ Checked _! Unchecked = partial

_! Unchecked = partial = partial

= partial = partial = partial

™ Checked = partial = partial

_! Unchecked ™ Checked = partial

= partial ™ Checked = partial

™ Checked ™ Checked ™ Checked

If the "Automatic Checkboxes" option is turned off, then the checked state of the parent is independent
of the settings of any of the other branches.

5.8  Editing Mind Map View Settings

Scale

Scaling allows you to scale the Mind Map so it fits on the number of pages you want it to. This option is
available on the View tab, and is only enabled when you have the Pages option turned on.

This is useful when setting up for printing, so you can have full control over pagination of the Mind
Map. The Fit to Page option in the pop down menu will fit the Mind Map to a single page.

[# Note that the page frames as shown are determined by the page size and orientation selected in
the page setup, and the margins you set in the printing setup panel, so if you intend to use
margins other than standard, and need exact positioning of the Mind Map on the page, you
should go into the page setup and select your paper size and orientation, then go into print setup
and set the margins, and then position and scale your Mind Map exactly as you want it.

Show/Hide
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You can show or hide the different attributes of the Mind Map as follows:

Checkboxes
Shapes

Link Lines
Boundaries
Collapse Symbols

Notes Indicators

Outline Numbers

Zoom

Shows or hides the checkboxes on the branches.
Shows or hides the attached shapes.

Shows or hides the link lines that link one graphic
or branch to another.

Shows or hides the boundaries around the
branches.

Shows or hides the "-" signs which allow you to
hide the children in a single click.

Shows or hides the indicators on the branches
that show whether there are any branch notes for
the branch.

Shows or hides the outline numbers as shown on
the branches.

The Zoom command allows you to select the zoom level for your Mind Map. The Fit To Window
command fits your Mind Map so it is all visible in your editing window. Zooming has no impact on what
size the Mind Map will print out - that is dependent on the scale.

Selecting branches and shapes

You can select branches just by clicking on them. If you want to add other branches to your selection,

you can either:

¢ Hold the Shift key or Control key down while you click on other branches and graphics

o Use the menu item "Select Siblings" from the Select control on the Home tab to add all the sibling
branches of the selected branches to your selection

¢ Use the menu item "Select Children" from the Select control on the Home tab to add all the children
branches of the selected branches to your selection

e Use the menu item "Select Descendants" from the Select control on the Home tab to add all the
children and grandchildren etc branches of the selected branches to your selection

¢ Hold the Shift key down while you drag a region around the other branches and shapes you want to

add to your selection (see below for details)

You can select multiple branches and shapes by using your left mouse button and clicking and
dragging across the canvas. Your selection area will be colored and as items are selected their
handles will appear to show they are included. Release the mouse button when finished. You can add
to the selection by shift dragging, and control dragging will add items that are not included and remove

ones that are.

To de-select all the selected shapes and branches, simply click elsewhere in the Mind-Map. To
deselect a single graphic, hold the Control key while clicking on it.

The commands in the ribbon bar operate on multiple selections, so you can select a number of shapes
and/or branches and perform the same operation on them all if you wish.
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7 Moving branches

Select the branch and drag it to a new location. You can make fine movements by holding down the
Control key and using the arrow keys.

When "Assisted Layout" mode is turned on, movement is restricted so as to help you create well laid
out Mind Maps. A copy of the branch will be left at the last acceptable location. If you let the branch go,
it will snap back to that position, unless you have dragged over another branch to begin a graft
operation, or between siblings to reorder siblings.

When "Snap Lines" is turned on, if a dragged branch is aligned with another branch below or above, a
blue dashed line will appear, showing you which branch NovaMind has found for you to align with. Also
if the position is close to equal distance between other branches, lines will be drawn indicating this,
and if you let go at that point, the branch will snap to exact alignment.

8 Grafting branches

Grafting a branch is moving a branch from one parent branch to another.

You can graft a branch just by dragging it on to a new parent branch. You will see a little circle on the
branch - drop the branch when the red fill is in the area towards the children end of the branch to graft
as a child, or in the top sector to graft as a sibling above, or in the bottom sector to graft as a sibling
below.

9 Deleting branches
To delete a branch, select it, then press the delete key on the keyboard.

10 Resizing branches

The shape of a branch can be changed either from the format tab, or from the context sensitive menus
|47, Note that for all except the FlexiBranches the text on the branch and the branch itself are
separate, and you can select the text on the branch and make it narrower than the branch if you so
desire. The text below is talking about when you select the branch itself rather than the text on the
branch.

The available branch shapes are:

Line A line which has the text of the branch above it. When selected, you will have
two handles, one at each end, which you can use for stretching the branch. If
you make it too short for the text, the text will wrap to multiple lines.

Rectangle A rectangle (or rounded rectangle) that may be filled in with color and have a
line around it's border. When selected, you will have 8 handles, one at each
corner, and one in the center of each side to resize the branch. If you make it
too narrow for the text, the text will wrap and make the branch taller
automatically. The text of a rectangle branch can be aligned in the center of the
branch, or at the top or bottom of the branch.

Oval An oval shape, which can be filled in with a color and have a different color
around the edge, similar to the rectangle. An oval can have the text in the
middle of the oval, or outside the oval above or below, and will wrap and
shorten the size of the oval portion if the branch is made too narrow for the
text.

FlexiBranch A line branch that can be altered in shape using any or all of the six colored
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11

12

handles.

Flexi Branches can be shaped in a number of directions and the text is
calculated to space accordingly to try and remain readable (although with tight
angles this will not be possible). By familiarizing yourself with the colored
handles you will learn what each handle allows you to do.

0 mE oo
Pew ¥

o ol oe

The red handles allow you to move the start and finish points of the branch.

The orange handles move horizontally and determine the sharpness of the
curve from the straight part of the line at the start (where adornments and
numbering is accommodated) and at the end (where it connects to the next
branch). By moving these further from the red handles you will create a more
gradual curve into the middle of your FlexiBranch.

The yellow handles can be moved any direction and determine the line shape
which your text is going to follow. The text calculates it's own spacing to try and
overcome crowding, however, on really tight angles crowding can still occur.
You can manually adjust the text kerning (spacing) by selecting the text to be
loosened or tightened and on the Home tab, choose the character spacing
option and either select from one of the predefined options or use the slider to
change it to your desired setting. By also using the purple branch resize
handles you can made the shape wider or narrower - thus creating text
wrapping or unwrapping if desired.

Hiding branches

In some circumstances you may want to work with only some of the branches showing, enabling you to
focus on either the main details or the particular portion of the mind map you are working on.

Note that hidden branches are NOT included in any text searches, spell checks, exported text or
printouts although exporting and printing does have an option where this can be over-ridden by
selecting the checkbox if desired although the branch will still remain hidden on your Mind Map.

You can hide specific branches by turning on the collapse symbols in the View tab (this will show a

small "-" icon beside the end of each branch). When you click on the icon beside a branch it will hide
the children of that branch.

Branch Options

The following sections tell you about using the Branch related commands. Note that in many ways
branches are just like shapes but with a few other properties.
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All of the settings for both branches and shapes can be applied to multiple items at the same time, so
if you want to edit the settings of a lot of branches at once, just select multiple branches at once by
dragging a selection around them, or control-clicking individual branches to add or remove them from
the selection.

For details on the branch specific options, see the sub-topics:

Changing Existing Branch Settings| 32

Changing the Branch Image| 33"

Changing the Branch Hyperlinks|34)

12.1 Changing Existing Branch Settings

To change the settings for the selected branches, you can use all the shape format settings on the
Format tab of the ribbon bar.

To change the shape of the selected branches to the desired shape, click on the Shape command in
the Branch Command Group. This will cycle through the branch shapes, or you can choose a specific
shape by using the pull down menu from the Shape command. You can also change the branch shape
from the context menu.

Branch Images

To set an image on the branch, you can use the Shape Fill command on the Style command group of
the Format tab, and choose the image option. This will allow you to select an image file from your
computer. You can drag an image onto the branch from the graphics library or another program such
as the File Explorer or Internet Explorer or FireFox.

You can set whether the text on the branch appears above, below, or centered vertically in relation to
the image by using the Style Dialog Box Launcher to show the Format Shape panel, and the setting is
under the Text settings.

[ Noimage data is thrown away in any image resize operation, and will still take up the full
amount of disk space in the NovaMind file, and will print at the maximum possible resolution
given the original image.

Other settings

In the Format Shape dialog box, you can also set things like the line weight, dashes, and the line style
of the connection between this branch and its parent. The connection setting is only applicable where
the branch is a second level branch or below.

If you have inserted a boundary, you can use the format settings to set a style for the boundary or use
the fill and line settings for the boundary. In order to do this, click on the line of the boundary to select
it, and then make the changes. In the Format Shape dialog box in the shape section, you can set the

boundary margin (the space between the branch and the boundary).

If you want to constrain the text width on the branch, you can turn on the Constrain setting, and set the
width - the text on the branch will be automatically wrapped when it reaches the length you specify.
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12.2 Using the Suggesterator

The Suggesterator is an optional download to accompany the NovaMind system and when installed,
integrates with NovaMind to propose words to help you build your Mind Map.The suggestions at the
top of the list are closely related to the topic you selected on the Map, and as you go further down the
list, they get further and further "off the wall".

The Suggesterator was designed to help you look for words that are either similar in meaning, opposite
or have some conceptual relationship to the word/s on your selected branch. This can be used to
identify other categories and subjects for inclusion in your Mind Map that you may not have thought of,
keeping momentum and movement in your Mind Map creation, and taking your thinking to new places.
This increases the potential for creating a Mind Map that is more thorough, provides more options and
more considerations depending on your subject. Besides this, it's fun!

For those of you who are more linguistically minded, NovaMind uses random selection from synonyms
and antonyms, chaining through sub-trees of ancestor chains through hypernyms, hyponyms and
meronyms to obtain more semantically obscure suggestions, choosing more closely related items for
further up the list, and items further away to populate the end of the list.

The Suggesterator is only available in English at this time.

If you have the Suggesterator installed on your system, you will see a lightbulb icon at the bottom right
of the window. If it is not showing there, you can download and install it from the NovaMind downloads
page on the website.

Click the lightbulb to show the Suggesterator™.

You can either select a branch, or type a word to look up the suggestions for. In the list below are the

suggestions that the Suggesterator came up with. If you don't see any you like, click the Give me
more! button for another set of suggestions.
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Suggesterator X

t}ink

[ Give me mare!

weighing
cerebration
change
cerebrate
opine
consider
purpose
concentrates
conceive of
alter

shift
advisement
imagine
mean
deliberation
consideration

[C] Include De| Add branches

[ The Suggesterator includes all words 3 letters long or more on the branch in its
search.

You can select multiple words by holding down the Control key as you click on the different items to
select them. If you want the definitions of the words included, check the Include definitions checkbox
before you click the Add branches option.

12.3 Branch Hyperlinks
Types of Hyperlink:

The five types of hyperlinks that can be attached to any branch are described below:
o & NovaMind file

. @ NovaMind Document URL

. @ Local file

o @] URL

o == Email message

NovaMind file
This links to another NovaMind document on your local machine. You must specify the name of the file
to open, and you can also specify the title of a branch to select when the file is opened.

4 To link to either another branch in the same Mind Map or another branch within the same
document but on a different Mind Map, leave the "Link to NovaMind File" text empty, and enter
the text of the branch you want to select.
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When a user clicks on this type of link, the file will be opened as another document in NovaMind. If you
specify a branch title to select, the Mind Map will be searched in the order that the graphics would print
in that Mind Map, and the first title that exactly matches the link specification will be selected, and
moved to the center of the view of the document.

Note that if you distribute the NovaMind document to other people, they will not be able to access the
linked document unless it is at the same relative location on their computer. You can specify the
location of a linked file using relative paths - the link needs to start with a . to refer to the current
directory, or .. to refer to the parent directory (relative to the directory where the mind map you are
editing is stored).

If you want a link to just open a new empty document, instead of typing a file name, type "<NEW>" as
the name of the file to open.

NovaMind URL

Linking to a NovaMind document on a URL requires full specification of the URL site and the
document name. You may also specify the title of a branch to select when the file is opened.

When a user clicks on this type of link, the URL will be opened as another document in NovaMind. If
you specify a branch title to select, the opened Mind Map will be searched in the order that the
graphics would print in that Mind Map, and the first title that exactly matches the link specification will
be selected and moved to the center of the view of the document.

Local file
This links to any file on your local machine and will open that file using the specified default application.

URL

This links to any URL, and will open that file using your default web browser application.

Email message
This link asks you to specify the recipient of the email, the title of the email and the message.

When you click on this type of link, the details you specified will be composed in your default email
application. You have the opportunity to edit the message before sending it. An operating system
limitation limits your messages to about 950 characters in length - if the length of the message plus the
titte and recipient address it more than 1031 characters, you will receive an error message, and the
link will probably not work.

I, Note that if you distribute the NovaMind document to other people, they will not be able to
access the linked file unless it is at the same relative location on their computer. You can
specify the location of a linked file using relative paths - the link needs to start with a . to refer
to the current directory, or .. to refer to the parent directory (relative to the directory where the
mind map you are editing is stored).

Below are a few scenarios showing how to do so.

If you have another file that was called file.txt in the same folder as your Mind Map, you can
refer to it as ".file.txt". e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\Documents\file.txt

If it was in the folder higher by one level in the hierarchy, you would refer to it with "..\file.txt"
e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\file.txt
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If it was in the folder below by one level in the hierarchy, you would refer to it with
"OtherFolder\file.txt" or ".\OtherFolder\file.txt" e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\Documents\OtherFolder\file.txt

You can combine this to refer to any folder relative paths e.g., the structure below would be
referred to as "..\..\OtherFolder\file.txt":

C:\Users\you\Documents\YourMindMap.nmind C:\Users\OtherFolder\file.txt
When you move the files to a different computer or different parent folder, for the links to
remain valid, you just need to maintain the relative locations of the files e.g. in the second

example you could move the files to:

C:\Users\SomeoneElse\Documents\YourMindMap.nmind C:\Users\SomeoneElse\file.txt

Adding Hyperlinks

You can add hyperlinks to a branch by selecting the hyperlink option from the context menu, or by
using the Hyperlink command on the Insert tab, or by dragging a file on to a branch from the Windows
Explorer, or by dragging a URL from your web browser on to the branch you want the hyperlink on.

The hyperlink panel looks like this:

Hyperlink Settings ]
Hyperlink
@ LIRL: hitp:/fwanes nova-mind.com/
@D iLocal File

F @)

Hyperdink

MovaMind File Link to File: Choose File...

NeovaMind URL
@ Local File

LURL

eMail

Hyperink Color
@ Default

Custom
| Ok |

You can add another hyperlink by using the + button or remove one by selecting it and pressing the -
button.
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13

You can set the type of the hyperlink to any of the options shown (described above).

You can set the color of the hyperlink icon to differentiate it from the other hyperlinks on the branch by
using the hyperlink color setting.

The options for the specific hyperlink type are shown on the right side of the panel, and are described
above.

Using the Hyperlink button (or hyperlink context menu item):

The hyperlink settings panel will be shown with a new hyperlink initially set to point to a local file (a file
on your computer). You can then select a specific file to link to or change the hyperlink type as
described below.

Dragging a file to add a hyperlink:

Drag a file onto the branch you want it linked to, and the hyperlink will be added.

Dragging a URL from a web browser to add a hyperlink:

Drag a URL from your web browser onto the branch you want to have the hyperlink on, and the
hyperlink will be added. Most web browsers have a small icon to the left of the web address which you

can drag. You will be shown the standard panel as above, allowing you to adjust the options for the
hyperlink.

i A Note about images:
If you drag an image on to a branch, NovaMind will think that you
want to add the picture to the Mind Map branch, instead of a

hyperlink to it. Therefore for images, you should use the hyperlink
panel to add it.

Editing a Hyperlink

You can edit the hyperlinks on the branch by Control-clicking on the hyperlink. This will display the
hyperlink settings panel and you can edit the settings there.

Deleting a Hyperlink

Select the hyperlink in the hyperlink settings panel, and click the minus button.

Following a Hyperlink

To follow a hyperlink on a branch, just click on the hyperlink.
Shape Options

This topic covers editing the attached shapes as well as the graphical aspects of branches.

Attached shapes are images, text and shapes that are attached to a branch but are not part of the
branch itself. The attached shapes move when the branch moves, but can themselves be moved
independently of the branch. They can be ordered so that they are in front of or behind the branch.
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All of the settings can be applied to one or more shapes and branches at the same time, so if you want
to edit the settings of a lot of shapes or branches at once, just select multiple items by dragging a
selection around them, or control-clicking individual items to add or remove them from the selection.
For details on the graphic editing options, see the sub-topics:

Shape Styles| 33

Line Settings 401

Fill Settings/ 41

TextSettings |41
Ordering Attached Shapes| 42

13.1 Shape Styles

Shape styles are a defined group of settings that can be applied to branches and shapes to change
the way they look. This can include things like line colors and line styles, fonts, and fill colors.

Shape styles allow you to set the background image, background color, branch coloring, layout mode,
outline numbering and various other settings with a single action.

NovaMind comes with a number of shape styles built in, but you can edit these, and create your own

styles. Each shape style may set some or all of the attributes mentioned above - these settings are
defined when the style is created.

To apply a shape Style

Select the branches and shapes you want to alter, and use the shape Style gallery to select the style
you want to use.

Note that if you want to apply a style to a boundary, you will need to click on the boundary to select it.
You can still have other shapes in the selection by control-clicking on them.

The Shape Style Browser
In the style gallery, you can click on the down arrow with the line above it to pop up the full gallery and

menu options. There you will see the option to Browse Styles. When you select this option, a browser
like this will appear:
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4 Browse Styles I} = [ = | (]

Category Built In Styles -
) Background Styles

@ Graphic Styles
Filter abe Abc Abc

No Filter LA — =
Filter by Themes Default Sha

MovaMind Default Theme
Colorful

Business. = Ao Abc Abc
Fastel A= LA LA A

Gray Busin... Default Sha... Pastel (Root) Pastel (Lev...

Gray Busin... Gray Busin... Gray Busin...

F F F

F F

-

Close || Apply Style

j

Initially, the option "No Filter" will be selected, but you can select whether you want to browse
background styles or graphic (shape) styles, and whether to filter by theme. If you want to filter by
theme and only show the styles as defined in the themes, you can click on a single theme or Control +
click to select multiple themes as shown in the example above.

You can then apply styles to the selected shapes. Note that as this is a floating dialog, you can leave it
showing if you like and use the styles as you format your Mind Map.

Creating Your Own Styles
In the style gallery, you can click on the down arrow with the line above it to pop up the full gallery and

menu options. There you will see the option to Edit Styles. When you select this option, the content of
the window will be changed to look like this:
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= Shame NovaMind 4 Platinum = 4
Home Insert Map Design View Format ‘ Shape Style Editor ] @ Help =
S 1.2 Format N ﬁghape Fill v || Clase Style Editar
6 o Tahoma b o
» L& Shape Outline ~

Numbering A C
Shepe B I =y 5
Branch || Child Mumbering ™~ Style 7] Editor

New Style | Mame: Default Shape Style | Sr:',e| [Sal.ne as new Style

Branch Settings

<<l <<

If you want to start your definition from an existing style, select it from the style gallery or from the style
browser. If you want to start from scratch, click the New Style button.

You can then use all the formatting options to change the settings of the shape, line styles, fill settings
and fonts etc to be exactly what you want.

The checkboxes indicate the elements of the style that will actually be applied to the shapes when you
apply the style. For instance, if you have the branch type set to line branch, and don't check the Apply
Branch Type checkbox, and then apply the style to a rectangle branch, then it will remain a rectangle
branch. If, however, you did check the Apply Branch Type checkbox, then when you apply the style to
a rectangle branch, it will turn it into a line branch. The same concept applies to all the other settings.

Once you have defined the style, you can save it as a new style, and it will appear in your style gallery
for use as you build your Mind Maps. If you find that it is not doing what you want it to, you can come
into the editor again, and select the style in the browser, and edit it. Then you would just click on the
Save button to update the style.

When you have finished defining your styles, click on the Close Style Editor command.
To delete a shape Style
Select the style you want to delete in the styles browser and click the Delete Style button.
13.2 Shape Outline Settings
You can use the outline settings command to alter the lines on your selected branches and shapes.
The popup menu allows you to set the most common settings of color, line weight, dashes, and corner

styles, and if you need the detailed settings like the amount of rounding on the corners, you can use
the shape dialog box launcher to open the Format Shape window and set the options you need.
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13.3

13.4

13.5

When you select the Default Outline setting, and specified color settings will be removed and the line
will be the default color - inherited from its parent, or rainbow color if you have that branch coloring
mode turned on.

Fill Settings

You can use the fill settings command to alter the fill for your selected branches and shapes.

The popup menu allows you to set the most common settings of color, removing the fill, or setting a
picture on the branch. Note that the picture setting will allow you to load an image from your computer.
If you want to set an image from the graphics library or from an image on a web page, you will need to
drag the image on to your branch.

When you select the Default Fill setting, and specified color settings will be removed and the fill will be
the default color - inherited from its parent, or rainbow color if you have that branch coloring mode
turned on.

Text Settings

If your selection includes branches or shapes that have text, the text settings on the Home tab will
allow you to change the settings. The options, by row are:

Font face: click the arrow to pop up the font selection. Each of the fonts is shown in its own font so
you can see what it looks like, and you get a live preview as you mouse over the different fonts. You
can also type in the combo box text area, and the closest matching font name will be chosen.

Font size: click the arrow to pop up the size selection, or type in the size you want, or click in the text
area and use the mouse scroll wheel to increase or decrease the font size. There are also two buttons,
one for making the font larger and one for making it smaller, and they have hotkeys Ctrl+Shift+> to
make it bigger, and Ctrl+Shift+< to make it smaller.

Bold: also accessible using Ctrl+B
Italic: also accessible using Ctrl+l

Underline: clicking this button cycles through no underline / single underline / double underline (also
accessible using Ctrl+U), and clicking the arrow beside the button gives you the additional option of
setting the underline color.

Strikethrough: clicking this button cycles through no strikethrough / single strikethrough / double
strikethrough, and clicking the arrow beside the button gives you the additional option of setting the
strikethrough color.

Character Spacing: allows you to set the spacing of the characters to either one of the preset values
in the menu, or use the slider to set the value explicitly.

Baseline Offset: allows you to set the height of the baseline of the characters to either one of the
preset values in the menu, or use the slider to set the value explicitly.

Font Color: allows you to set the color of the text.
Corner Settings

Rectangular shapes, boundaries, and rectangular branches can have their corner settings changed.
The basic settings are available in the Shape Outline popup of the Format tab, but if you need to adjust
the amount of rounding for instance, you will need to use the Dialog Box Launcher to open the Format
Shape dialog and change its settings.
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13.6 Ordering Attached Shapes

When you have attached shapes on a branch, you can order them relative to each other and to the
branch by using the Arrange commands on the Format tab, either bringing them one step forward or to
the front, or one step backward or to the back.

14  Mind Map Tools

Please see the detail sub-topics covering each of these topics:

Finding Text/ 42

NovaMind Outliner| 43

Adornments| 44
Graphics Library/| 44

Mind Map Navigator /451

Branch Notes/ 461

14.1 Finding Text

Showing the Find Panel

To display the Find panel, press Ctrl+F. The image below shows the find panel with the additional
options displayed. By default the find searches in all maps in all open documents.

1 Find ][ =[]

1E5

[ Replacelﬂeplar_e .&.II]

# | More Options

LookIn Options
All Open Documents [C] Match Case
Current Document
Selected Branches
Current Map

ew technologies
Cpportunities
WVulnerabilities

3 Resulis

Searching for Text
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14.2

To search for some text in a Mind Map, first enter the text to search for - either by typing it in, or
pasting the text from somewhere else.

If you select the option "Current Document”, and have several Mind Maps in a single document
NovaMind will search all the Mind Maps in your document.

If you select to search in all open documents, then NovaMind will also search all other documents you
have open at the time.

The Result table is populated with the search results, and you can select the result you would like to
view by clicking on it.

You can use the find panel to replace occurrences of the text you are searching for either one at a time
or all at once. Just enter the replacement text in the find panel, and use the Replace or Replace All
button.

NovaMind Outliner

You can display the outline panel by selecting the Outline View icon at the bottom right of the window.

A whole Mind Map can be built by using the outline panel and allows the user to create, edit and delete
branches as well as copy, paste, graft and rearrange their order.

The Outline Panel has it's own toolbar with the following functions (from left to right as pictured below):
ootk Y AR R

Add branch, add sibling and delete branch: These are the same icons as those used within the
Mind Map and perform the exact same functions.

Move up and move down: These shift the selected row/s up or down one position, if possible.

Move left: Moves the selected branch to the left by one level starting with the right most branch. If a
parent has children that are not selected, they will move with the parent while children that are selected
will be shifted left individually.

Move right: Moves the top selected branches right by one level, if possible. All of the children of any
moved branch will remain in the same relative position.

Indent: This function is the same as move right.

Outdent: Shifts the selected branch left by one level, if possible. If a parent and one of its children are
selected, the child will remain a child of the parent after the outdent.

Group: Creates a new branch and makes all of the selected branches children of the new branch.
uUngroup: Makes the children of the selected branch into siblings.

Expand & Collapse One Level: Expands the selected branch by one level showing relevant child
branches. Collapse hides all children by one level.

Expand & Collapse Completely: Will expand or collapse all the children of the selected branch,
regardless of how many layers there are.

Expand & Collapse All: This will expand or collapse your entire Mind Map with all the branches on it.
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When creating and editing your Mind Map using the Outline Panel, you can use the hotkeys| 431 for
quick functionality such as adding new branches, editing, formatting text etc. By using your mouse you
can group select for various functions as well as click and drag to graft to a new location or re-order
branches. While dragging to a new location an insert line will appear to indicate a potential position has
been found where it can be grafted, note that the line will move left or right to indicate which indented
position it will be inserted.

14.3 Adornments

What are adornments?
Adornment graphics are small icons that you can attach to any branch and they sit either left or right of
the branch numbering before the branch text.

Showing the adornment selector
To show the adornment selector, click on the smiley face icon at the bottom right of the window.

Adding adornments to branches
Select the adornment you want to use, and drag it on to the branch.

Changing the sequence of adornments

If you want to have the adornments in a different order than originally placed on your branch, drag
them into a different order. You can also drag outline numbers into a different position relative to the
adornments.

Deleting adornments
Delete adornments by dragging them out of the branch (but not on to another branch). Outline
numbers can not be deleted by this method - to remove outline numbers, turn outline numbering off.

Moving an adornment to a different branch
Drag the adornment to the other branch.

Creating your own adornments

You can add your own custom adornments under "Custom Adornments”. To do this, you will need to
copy the files you want to use into a specific folder, as detailed below. Steps to accomplish this are as
follows:

Select the images you want to add to your list of adornments. Any image type recognized by MacOS X
will do. The images should all be 16 pixels wide and 16 pixels high. If they are not that size, NovaMind
will resize them to that size when you use them.

From your home folder, select a folder called Library. Inside this folder, create a folder called
"NovaMind" (if it doesn't already exist).

Inside the NovaMind folder create a new folder called "Custom Adornments".

Copy your image files into the "Custom Adornments" folder. If you want to organize your images, you
can also create folders inside the Custom Adornments folder, and these will be reflected in the
adornment selector.

If you have the Adornment selector open, click the Reload button to refresh the items in the list.

14.4 Graphics Library

You can show the graphics library by clicking on the picture icon at the bottom of the window. You can
then search for images within your library.
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The graphics section includes all the graphics from your graphics library. The full graphics library
comprises of over 1,400 images in a number of subject categories such as Arrows, Business,
Computers, Education & Science, Food & Drink, News Media & Entertainment, Objects, People,
Transport and more. Because of the large size of the library, only some images are distributed within
the program, the rest are available by download off the NovaMind Downloads webpage and are free.
Please note that there are separate downloads for Express & Pro, and the Platinum edition, as
Platinum has significantly higher quality images, and has over 900 more images than Express & Pro.
Platinum images will not be recognized in Express & Pro versions of NovaMind.

! e graphics are encrypted, and only available for use within NovaMind. When you install the
Th hi d, and onl ilable f ithin NovaMind. Wh i I th
graphics libraries, you need to restart NovaMind, and then the graphics will appear in the

NovaMind graphics library.

You can use the graphics within your Mind Maps, and can publish Mind Maps with the
graphics on them but you are not allowed to sell or distribute the images on their own.

In the Configuration section, you can add additional directories to load images from so you have easy
access to your images.

Upon finding an appropriate image:

You have the following options:

¢ Drag the image over an existing mind map branch and the graphic will be applied to the background
of that branch.

e While a branch is selected, drag the image over the canvas and drop to attach it to the selected
branch as a floating attached shape.

14.5 Mind Map Navigator

The Navigator allows you to find your way around large Mind Maps:

Mavigator - SWOT £

The blue rectangle shows the visible portion of the NovaMind document. Click on the area within the
navigation image and your document will scroll to that section. You can also drag the rectangle to a
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new location - the document will scroll as you go.

You can also scroll the document by pressing the spacebar while dragging the background of the mind
map.

Note also that you can use the arrow keys to select different branches, and they are scrolled so they
are visible.

14.6 Branch Notes

The branch notes area allows you to edit branch notes. Click on the notes button on the bottom right of
the window to display the notes. You can type notes for the selected branch.

15 Context Sensitive Menus

Context sensitive menus are menus that appear when you right-click on different elements within a
NovaMind Mind Map.

There are three different contexts used within NovaMind:

While you are Editing Text/ 461

When you click on a Branchl 471 (while not editing the text on the branch)

When you click on the Canvas| 47

15.1 Menus While you are Editing Text

While you are editing text, if you right-click on the text, you will see a number of options like the

following:

Microsoft Sans Serif -

Font Size k
B d Ctrl+B
I Ralic Ctrl+1
d Cut Ctrl+X
53] Copy Ctrl+C
F'a Faste Ctrl+V
A BranchStorm

The first item allows you to select the font. The second allows you to select the text size. The rest of
the text options are pretty self explanatory.

The last item is BranchStorm - when you click on this and start editing your branch text, whenever you
press Enter, a little # icon is inserted in the text, and you can continue typing. When you either pause
typing, or finish editing the branch, the text before the first icon is left on the branch, and all the text
between the other # icons is split onto child branches.
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15.2 Shape Context Menu
If you right-click on a branch while you are not editing the text of the branch, you will see the following
menu items:
Cut
Copy
Paste
Edit Text (F2) - puts you into edit mode on the selected branch
Edit Branch Notes - switches your sidebar to show the branch notes
Arrange - bring shapes in front of others or the branch, or send them behind
Hyperlink... - show the hyperlink editing panel
New Map from Branch - takes the selected branch and makes it the title of the new map, and adds the
children branches as children of the newly created map title.
Format Shape... - shows the shape formatting panel.

15.3 Background Context Menu
When you right-click on the canvas (i.e. the background where there are no branches or attached
graphics), the following menu is shown:
Snap Lines - this item is checked if you are using snap lines - select this option to turn snap lines on or
off.
Page Frames - shows whether you are showing page frames or not - select to turn this option on or
off.
Format Background - shows the background formatting panel.

16 Layout Assistance
NovaMind has three different levels of layout assistance to help you with creating great looking Mind
Maps without getting in the way of your creativity. This section describes the options in detail.

16.1 Free layout
Free Layout Mode allows the user to place branches and attachments at any chosen position on the
Mind Map. This option provides flexibility to drag individual branches to any desired position including
the extremities of the page, close to each other etc, however, this mode does not prevent branches
from overlapping.

16.2 Assisted layout

Assisted Layout mode helps the user to maintain spacing between the branches. The branch spacings
that are maintained in assisted layout mode are those set in the Branch Spacing settings.
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16.3 Controlled layout

Controlled Layout mode arranges all branches and text to create a balanced page centerd around the
Mind Map title. The spacing between branches and siblings is also controlled by the settings on the
layout assistance settings dialog box. Grafting branches is a matter of clicking and dragging to the
desired location - you can not move the branches yourself apart from resizing or grafting them.

17  Canvas size, Zooming and Scaling

You canvas is the area on which you draw your Mind Map.
Pages Mode

There are two modes you can use when working with your Mind Map. The first is with the Pages option
in the View tab turned off. When creating Mind Maps in this way, you are not worried about how many
pages you are using, as there is an unlimited canvas size that just keeps growing as your Mind Map
requires.

However, sometimes you may need to be concerned about how many pages your Mind Map will print
on, and exactly where your Mind Map will fit on the pages. In this case, turn on the Pages option. Now
the canvas size is in multiples of the page size you set up in your page setup, and takes into account
any margin settings you have set in the print panel (otherwise it uses the default margins for the
printer). While drawing your Mind Map if the branches extend close beyond the boundaries of the
canvas, and extra page is added in that direction.

Zooming

Zooming in enlarges both the canvas and the Mind Map, so you just see the whole thing a different
size. It does not affect the number of pages your Mind Map will take up when printed.

You can zoom in and out by:

Using the popup menu at the bottom of the document window

Using the zoom options on the view tab of the ribbon bar.

Typing in a zoom value in the text field at the bottom of the document window and pressing Enter
Clicking in the zoom text field at the bottom of the document window and using your scroll wheel to
zoom in or out.

Holding down the Control key while scrolling up or down with your mouse scroll wheel

Scaling
Scaling allows you to scale the Mind Map so it fits on the number of pages you want it to.

You can scale by using the commands in the scale section of the Pages command group in the View
tab of the ribbon bar. This is only enabled when you have the Pages option turned on.

When preparing for printing, you can both scale the Mind Map, and move the Mind Map so that the
page breaks occur at exactly the points you want them to.

18 Shortcuts

These topics give you details on the keyboard and mouse shortcuts to make working with your Mind
Map quicker and easier.
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18.1

Keyboard

The following are the ordinary keys that have special operations assigned to them in NovaMind:
Arrow keys - When not editing the text of a branch, the arrow keys can be used to select other
branches to work with. The text of the branch is selected so that you can just press Return to edit the
text of the branch.

Control+Arrow keys - This nudges the selected branch slightly in the direction of the arrow key.
Delete - Deletes the currently selected branch or graphic (when you are not editing the text)

Enter - If you have the a branch selected, but are not editing it, pressing Enter adds a sibling branch. If
you are editing, Enter finishes editing. If you want a new line in your branch text, press Ctrl+Enter. If
you are in BranchStorm mode pressing Enter inserts a marker so you can start typing the text for the

next branch.

Esc - If you press Esc while you are editing the text of a branch, this will end the editing operation
without saving your edits.

Ctrl+Insert - inserts a picture in the text you are editing.

KeyTips

Most of the hotkeys in NovaMind are implemented through the KeyTips system on the ribbon bar. You
can use the KeyTips to guide you through the options for hotkeys. To activate KeyTips, click the Alt
key. You will see little tags showing you the options for the currently selected area of the user interface.
When you first press the Alt key, you will be shown the key tips for the top level, like this:

P=N=rY NovaMind 4 Pro RC1 - =X
B inlnls
" Home & Insert MapDesiogn  View  Format L7 r‘_—lf ¥
] L] w—1o] : & E
sy E = y Sh Fill * WA
Ar8 S B vere - v - [a] [EEE) 4 N
2y b ChId g A F AT - Y = Qui: Zsr'ape Outline * % Replace
. ranc ape ||| vabew by Xiv|| A | | ,
Pa'“e Fr) . Branch T = — Styles « [ select -
Clipboard Insert Font Paragraph Drawing P Editing
@ ¥ MindMap-Title | ¥ MindMap-Title | ¥ dfgdsfsdfgfsdf -:-Bl -

qwer O

F] (T 3

100 D L IEE Hp

-

Then when you choose a top level item, you can then choose the detail options etc until you get the
command you want.

So for example to add a new branch, you could use Alt + H + IB, then select the branch type and press
Enter, or you could do it from the Insert tab with Alt + | + CL for a line chld branch.

Shortcuts using the Control key

The following is a list of the other hotkeys for specific operations:
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18.2

Ctrl+A
Ctrl+Shift+A
Ctrl+B
Ctrl+C
Ctrl+Shift+C
Ctrl+F

Ctrl+l

Ctrl+L
Ctrl+Shift+L
Ctrl+N
Ctrl+O
Ctrl+P
Ctrl+S
Ctrl+Shift+T
Ctrl+U
Ctrl+V
Ctrl+Shift+V
Ctrl+X
Ctrl+Y
Ctrl+z

Ctrl+ <

Ctrl+ >
Ctrl+Ins

F1

F2

Alt+F4

F10

Mouse

select all shapes & branches, or select all text while editing
create attached text graphic on the selected branch
bold / unbold text

copy selected shapes / selected text

copy font from selected text

find

Italic/Un-italic

Insert/edit inline hyperlink when editing text

Remove hyperlink when editing text

new file

open file

print

save

paste unformatted text

Underline/Double underline/Un-underline

paste

paste font

cut

redo

undo

Make selected text smaller

Make selected text bigger

Insert a picture at the selected location while editing text
Help

Edit selected branch

Close currently active window

Show the keytips for hotkey selection (same as pressing Alt)

The following shortcuts are available in conjunction with mouse clicks:

Click - select shape

Drag - move selected shape, or if dragging on the background, does a rubber band selection of

shapes

50

Shift-Drag (on the background) - adds any unselected shapes in the selection area to the selection

Control+Drag (on the background) - does an XOR selection with the currently selected shapes (if they
were selected, they will be unselected, and vice versa)

Control+Scroll wheel - Zooms the Mind Map (makes it look bigger or smaller on the screen without
changing the number of pages it will fit on)

Control+Shift+Scroll wheel - Scales the Mind Map (makes it fit on more or fewer pages)

Shift+Click - Adds the clicked on shape to the selection

Control+Click - Adds the clicked on shape to the selection if it was not there, or removes it from the
selection if it was there.

Shift+Drag (while resizing an attached image shape) - stops constraining the aspect ratio of the image
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19

that is being resized
Shift+Scroll wheel - Scrolls horizontally

Select+Drag text from another program - copies it onto your text that you drop it on, or creates an
attached text shape if you drop it on the canvas.

Drag URL from a web browser to a branch - creates a hyperlink.

NovaMind Options

Options allow you to set the way you want new documents, new Mind Maps, and new branches to
appear, and a number of global options to change the operation of the program.

You can show the Options by selecting the NovaMind Options button from the application menu.

Saving

If you have "Save Backup Copy" turned on, whenever you save a NovaMind document, the previous
version of the file is saved as a backup. This file has the extension .nmbak - if you have a problem with
your main file, you can rename your .nmbak file to .nmind and open it in NovaMind.

When you have the auto-save feature active, NovaMind will save your Mind Map at the specified
intervals. This is the normal save operation, just the same as if you had used the Save menu option. If
you have not saved the document yet, you will be asked to give the file a name.

Check for Updates

You have three options for checking for updates:

e Only check manually - NovaMind will not ever automatically check for updates - to check for
updates, you will need to come to this pane in the Options and click on the Check Now... button.e

e Check on startup - NovaMind will check for updates in the background, and notify you if there is a
new version available.

If NovaMind finds a newer version, it will display details of the new version and allow you to download
it.

¥y Point releases (e.g. 4.0 to 4.1) are free
updates, but updates that increase by a full
number (e.g. 4.5.2 to 5.0) are paid upgrades,
and you will need to purchase an upgrade
license to use the new version.

Show Snap Lines
Snap lines allow you to more easily line up branches when you are moving them around on the Mind
Map. Check this option if you want to have snap lines turned on.

Keyboard Shortcuts

There are standard keyboard shortcuts available for adding branches and many other common
operations. To change to different options, just click on the item you want to change and type the new
keystroke.
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20 Contacting NovaMind

This topic covers the various ways to contact NovaMind.
20.1 Web site

The NovaMind web site address is: www.nova-mind.com

If there are any issues with the web site, please send an email to: webmaster@nova-mind.com

20.2 Emall

In most cases email is the best way to reach us.

General information: info@nova-mind.com

Sales enquiries: sales@nova-mind.com

Technical support: support@nova-mind.com

Subscribe / unsubscribe for news updates & newsletters: registrations@nova-mind.com

Contact the Newsletter Editor: news@nova-mind.com

20.3 Post/ physical address
Our physical address is:

6/66 Commercial Drive
Shailer Park

QLD 4128

Australia

Our postal address is:

PO Box 4503
Loganholme DC
QLD 4129
Australia

20.4 Sending feedback

Please use the "Help / Send Feedback" menu item. We are committed to making NovaMind the best
possible, and are keen to get your feedback.

20.5 Reporting a defect

Please use the "Help / Send Feedback" menu option, and fill in as much information you can about the
nature of the problem and how to reproduce it. We want to hear about any fault you find, no matter
how small, and will aim to fix it promptly.

Also if you experience a crash, we have built in a crash reporter that allows you to send the relevant
information to us so that in many cases we can see exactly what happened so we can fix the issue
quickly. Please include your email address so we can contact you if necessary.
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20.6 Checking for updates
Connect to the Internet and use the "Help / Check for Update" menu item. You will be shown
information about any application updates that are available. You can also have NovaMind
automatically check for updates - this is set up in the Options panel st

You can download and install new versions of NovaMind from our web site.
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